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About This Document
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ToolBook is either a trademark or registered trademark of SumTotal in the United States and/or other countries.

Semprex is either a trademark or registered trademark of Semprex Corporation in the United States and/or
other countries.
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OMNIC Atlµs 9.14

Release Date: Jan-2024

Supported Operating Systems
• Windows 10 64-bit

• Windows 11 64-bit

New Features
None

Resolved Issues
None

Known Issues
None

OMNIC Atlµs 9.13 Hotfix 6
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Release Date: Nov-2023

Supported Operating Systems
• Windows 10 64-bit

• Windows 11 64-bit

New Features
None

Resolved Issues
Incorrect focal distances used to collect discrete point maps
When collecting discrete point maps in OMNIC Atlµs, it has been possible to set the focus point for each point
individually such that the software moves to that focus point when collecting the map. The software was using
the focal value for the following datapoint when collecting.

This affected OMNIC, OMNIC for Dispersive Raman, and OMNIC Picta. All products are fixed with this release.

Known Issues
None

OMNIC Atlµs 9.13 Hotfix 5

Release Date: Jun-2023

Supported Operating Systems
• Windows 10 64-bit

• Windows 11 64-bit

New Features
None

Resolved Issues
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Can Not Use TQ Analyst with Maps
When trying to use a TQ Analyst measure-only method with a map in OMNIC Atlµs and OMNIC for Dispersive
Raman by going into Quant Setup and choosing the method, Quantify remains greyed out. Also affects OMNIC
and OMNIC Picta.

Known Issues
None

OMNIC Atlµs 9.12 Hotfix 3

Release Date: Apr-2021

Supported Operating Systems
• Windows 10 64-bit

New Features
None

Resolved Issues
OMNIC Atlµs blend feature does not show video image
Recent versions of the Windows 10 OS caused the blend feature to show only the chemical image and not the
video image.

Known Issues
None

OMNIC Atlµs 9.12 Hotfix 1

Release Date: Feb-2021
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Supported Operating Systems
• Windows 10 64-bit

New Features
None

Resolved Issues
SaveMapAs does not always work
The SaveMapAs command failed to save a map if the map had not changed.

Use of markers with point map problem
When using markers in point maps the markers were used as points to collect. This has been corrected to not
collect the markers as spectral points.

Known Issues
None

OMNIC Atlµs 9.11 Hotfix 6

Release Date: Apr-2020

Supported Operating Systems
• Windows 10 64-bit

New Features
None

Resolved Issues
Map file signature not successful
In some map files, when verifying a map file signature after signing it, the report will say that the file was
modified since it was signed.
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Known Issues
None

OMNIC Atlµs 9.11 Hotfix 5

Release Date: Feb-2020

Supported Operating Systems
• Windows 10 64-bit

New Features
None

Resolved Issues
Time stamp when splitting a map file
The discrete point maps when split did not have the correct time stamp in the spectrum. This has been
resolved.

Cannot sign a map file in a secured folder
When signing a map file in a secured folder it would fail signing when logged in with admin or similar accounts.

Map collect does not prompt for signature
When a map collect was complete, it did not prompt for a signature.

Save Map As failed in secure environment
When saving a map file to a secure folder, the file save would not copy the file and would fail.

Known Issues
None

OMNIC Atlµs 9.11 Hotfix 4
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Release Date: Nov-2019

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 10 64-bit

New Features
None

Resolved Issues
Audit message for save profile CSV
When saving a map profile in CSV, an audit event will be sent to record the action.

Audit message for map print
When printing a map, an audit event will be generated.

Known Issues
None

OMNIC Atlµs 9.11 Hotfix 3

Release Date: Oct-2019

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 10 64-bit

New Features
Audit message for save profile CSV
When saving a map profile in CSV, an audit event will be sent to record the action.
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Resolved Issues
Date stamp incorrect when splitting discrete map spectra
The date time stamp for split files with larger data sets set the time incorrectly.

Known Issues
None

OMNIC Atlµs 9.11 Hotfix 1

Release Date: Sep-2019

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 10 64-bit

New Features
None

Resolved Issues
Date stamp incorrect when splitting discrete map spectra
The date stamp on files created by the split map command using a discrete map file did not have the correct
time stamps. The time stamps will now match the time stamp of the spectrum when copied from the map to a
single spectrum window in OMNIC.

Known Issues
None

OMNIC Atlµs 9.9 Hotfix 2
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Release Date: Feb-2019

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

• Windows 10 64-bit

New Features
None

Resolved Issues
Changing operating system region loses video calibration
When video has been calibrated and then the region information is changed in the operating system so that
decimal point type is not correct, the video calibration is lost. The fix for this is to edit the OMNIC_MC.INI file.
Change the decimal point in the calibration section to use either a comma or period to match the local settings
then the calibration can be used.

Maps do not collect when using security suite
When starting a map collect with security setup, the maps would not collect.

Known Issues
None

OMNIC Atlµs 9.9 Hotfix 1

Release Date: Oct-2018

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

• Windows 10 64-bit
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New Features
None

Resolved Issues
Software becomes unstable when collecting or processing large map or mosaics
Extensive changes to improve memory usage, user warnings and error trapping when collecting larger maps
and mosaics.

Known Issues
None

OMNIC Atlµs 9.9

Release Date: 19-Sep-2018

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

• Windows 10 64-bit

New Features
None

Resolved Issues
Reprocessing a map file and saving with a new name loses time stamp information
With this release, reprocessing a map file no longer loses time stamp information

Known Issues
None
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OMNICMC 9.8 - Hotfix 1

Release Date: Jul-2017

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

• Windows 10 64-bit

New Features
None

Resolved Issues
Fix random Continuum microscope ATR map issue
OMNICMC is a component used with OMNIC Atlµs. When collecting maps on the continuum microscope using
the ATR, the map collect would occasionally stop collecting and lock up OMNIC.

Split Map file folder button disabled
When selecting the split map file menu item, the folder selection button is always disabled so that the folder
cannot be changed.

Known Issues
None

OMNIC Atlµs 9.8 - Hotfix 1

Release Date: Jun-2017

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit
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• Windows 8.1 64-bit

• Windows 10 64-bit

New Features
None

Resolved Issues
Change use of aperture for PICTA
A change in OMNIC Atlµs 9.8 introduced a problem with the aperture usage when run with OMNIC PICTA.
This does not affect OMNIC map usage.

When not using Data Security the browse button was disabled for split map
A change in OMNIC Atlµs 9.8 introduced a problem that disabled the browse button in the split map dialog
when not using data security. The browse button is now disabled only when that option is selected in a security
environment.

Known Issues
None

OMNIC Atlµs 9.8

Release Date: May-2017

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

• Windows 10 64-bit

New Features
New Data security features
See the OMNIC release notes for details
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Resolved Issues
Split map file save problem
When doing a split map command the file extensions were not correct. This has been fixed to produce SPA
type files.

Cursor on map not controlled by arrow keys
The cursor keys will not move the arrow to select spectra on the map window. This has been corrected to move
the selected spectrum choice when the arrow keys are used and the map window is selected.

Single point maps cannot be processed
It was found that single point maps could not be processed using the change data spacing command. It was
also found that the data could not be saved for other processing cases.

Known Issues
None

OMNIC Atlµs 9.7

Release Date: Oct-2016

Supported Operating Systems
• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

• Windows 10 64-bit

New Features
None

Resolved Issues
Searching a spectrum in a single point map causing a crash
This has been corrected.
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Known Issues
None

OMNIC Atlµs 9.6

Release Date: May-2016

Supported Operating Systems
• Windows XP SP3 32-bit

• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

New Features
Complete the support for the Prior Optiscan III
Fully implemented

Prevent orphaned operation of OMNIC_mc.exe
Terminate the application if no parent applications are running.

Resolved Issues
OMNIC Atlµs Command Math resultant window has old name
Warn that need to save as new map before continuing

Background collect with array using pixel as same location
Collecting array background with all pixel at the same location, the background spectrum was not at the
defined spot.

Crash when opening software
Fixed crash when opening the OMNIC Atlµs software.

Map history not saved
Data processing history was lost when saving a map file with the Save Map command.

Large map collect crash in mosaic
Picta crashed on a large map (in preview) after collecting a mosaic.
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Map changes not updating digital signature state
Digital signature on a map file persisted even if the map file was changed.

Known Issues
None

OMNIC Atlµs 9.5

Release Date: Nov-2015

Supported Operating Systems
• Windows XP SP3 32-bit

• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

New Features
None

Resolved Issues
Importing ENVI file format files did not work.
Fixed to import small ENVI files

Exporting of map files to ENVI that were larger than 256 by 256 truncated the file
Changed to export larger file sizes

Known Issues
None

OMNIC Atlµs 9.4
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Release Date: Oct-2015

Supported Operating Systems
• Windows XP SP3 32-bit

• Windows 7 32-bit

• Windows 7 64-bit

• Windows 8.1 64-bit

New Features
Add support for Windows 8.1
Windows 8.1 now supported

Provide support for the Prior Optiscan III
Prior Optiscan III microscope stage support added

Resolved Issues
None

Known Issues
None

OMNIC Atlµs 9.3

Release Date: Oct-2014

Supported Operating Systems
• Windows XP SP3 32-bit

• Windows 7 32-bit

• Windows 7 64-bit

New Features
Improved video images
Improved how the video images look in the mosaic
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Update driver for Sentech video camera
A newer version of the Sentech camera driver is being used, version 3.0.5.

Resolved Issues
Fixed issue when copying extracted line map
An issue occurred when copying an extracted line map. It would not save correctly.

Fixed issue when collecting new backgrounds in discrete point maps
Backgrounds did not collect after a defined time period when collecting a discrete point map.

Fixed issue that stage too close to ATR when prompted to insert tool
When the prompt to insert the ATR tool was shown, the stage was too close to safely insert the tool. The stage
is now moved lower to allow more room.

Fixed issue of seeing aperture image in overlaying OMNIC windows
When the OMNIC Atlµs window was open and another OMNIC window overlaid it the aperture image would
sometimes show through.

Fixed issue of Kramer’s Kronig not working with area maps
When attempting to perform Kramer’s Kronig on a map it would fail the operation.

Known Issues
None

OMNIC Atlµs 9.1

Release Date: Jul-2012

Supported Operating Systems
• Windows XP SP3 32-bit

• Windows 7 32-bit

• Windows 7 64-bit

New Features
Added support for the iS50 Raman Module
New iS50 Raman module is now fully supported
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Microscope selection improved
When switching to a microscope beam path, OMNIC Atlµs will automatically switch to the appropriately
configured microscope. This eliminates the need to manually change configurations via the OMNIC Atlµs
System Configuration dialog.

Attach video images to spectra
Video images from OMNIC Atlµs can be attached to individual spectra in OMNIC.

Resolved Issues
Map and Profile windows will only display file name and not path
Due to length, the title bar will only display the file name and not include the path. The full path is available in
the Filename entry of the Collection and Processing Information window.

Fixed issue when importing spectra
An issue occurred when importing too many files. User was not warned that a failure occurred, but files were
not imported.

Fixed issue when extracting a line map
Extracted line maps may have been incorrectly saved as area maps causing problems with post processing.

Known Issues
Collect background after sample
Currently the experiment option to collect background after sample does not work for maps.

OMNIC Atlµs 9.0

OMNIC Atlµs 9.0 was never released.

OMNIC Atlµs 8.3

Release Date: Sep-2011

New Features
Added support for 64-bit Windows.
Updated along with the rest of OMNIC to support 64-bit Windows.
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Resolved Issues
ATR mapping may produce exception Error:
When collecting an ATR map an exception error may be displayed if the OMNIC Atlµs window is open during
the collect.

OMNIC Atlµs 8.2

Release Date: Feb-2011

New Features
Added support for Windows 7
Updated along with the rest of OMNIC to add support for Windows 7.

Resolved Issues
Analyze Images produces exception Error:
When using the Image Analysis tool an exception error will be displayed and the feature will work.

Point map displays Single Beams instead of ratioed spectra:
When collecting a Point map with multiple aperture sizes, a single beam may be displayed instead of ratioed
spectra.

OMNIC Atlµs 8.1

Release Date: Mar-2010

Resolved Issues
Thermo Software IQ failed on installation with µView:
An error was generated with the Thermo Software IQ report because of different versions of shared files
between µView and OMNIC Atlµs. This issue has been resolved. No changes to the OMNIC Atlµs code were
made.
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OMNIC Atlµs 8.1

Release Date: Dec-2009

Resolved Issues
Copy on X and Y profiles is now fixed:
Copying X and Y profiles from the profile window into a standard OMNIC window now works as expected.

Adding a marker previously failed:
In the previous version of the software adding a marker with the Marker toolbar tool generated an error
message that has been corrected.

Oversampling error using the array detector on a Continuum XL when using either
just the right or left column alone, elements 1 to 14:
Stripes appeared in the data when using a single column of the array detector for a Continuum XL and using
only elements 1-14.

OMNIC Atlµs 8.1

New Features
Map Math:
When two like maps are opened in OMNIC Atlµs, the Map Math function is available. It provides the following
map math functionality:

(Map 1 = A and Map 2 = B and k = constant):
    A/B
    B/A
    A*B
    B-A
    A+kB
    A-+kB
    (A-kB) / (A+kB)

Send to OMNIC Specta:
A right-click option has been added to send map spectra to the OMNIC Specta application as temporary files.
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Resolved Issues
Copy on profiles of extracted line maps:
In previous versions of OMNIC Atlµs if a line map was extracted from an area map, spectral copy was not
available from the profile.

X and Y dimensions are now in the title of extracted spectra:
When spectra are extracted they now contain X and Y dimension information.

Spectrum numbers are now in the title of extracted spectra:
When spectra are extracted they now contain a spectrum number associated with the collection order.

Spectrum collection and processing information is now included in extracted
spectra:
When spectra are extracted they now contain collection and processing information.

Spectrum collection time is correct for extracted spectra:
When spectra are extracted they now contain an appropriate collection time instead of just the start of the map
collection.

Interferogram data is now attached to split map spectra:
When map files are split using the Split Map command if interferogram data is available the appropriate sample
and background interferogram will be attached to the split map spectrum.

Saving discrete point map files is now working correctly:
Saving discrete point map files after processing now works correctly.

Improved estimation of map collection time:
The estimated collection time of a map has improved.

Workaround to get better resolution quality:
To get better image quality we recommend sending the video image to a virtual printer driver such as Microsoft
Office OneNote, Microsoft Office Document Image Writer or a similar product. The two applications mentioned
above are both part of the Microsoft Office Suite or they could also be downloaded from the Microsoft website.
By using any of these types of products you can print the document to the driver which will save the image
directly to a file or to an application for viewing, which is typically in the printer resolution of 300 dpi or higher.
The image can then be copied and pasted into any document.

Using saved background file for discrete point map collections now works
properly:
When using the Saved Background File option for collection of discrete point maps, the collected spectra are
now in the correct final format.

All background options work properly when collecting discrete point maps:
All background options now work properly for collection of discrete point maps.
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Exact dimensions now appear on the video image while moving the joystick:
When moving the joystick, the exact dimensions now appear on the video image.

Drawing vertical lines works correctly:
In previous versions of OMNIC Atlµs it was not possible to draw a vertical line from top to bottom correctly, it
now works correctly.

Cursor mode is now able to reset when in profile map:
The cursor mode can now change back to Select and Zoom mode from Ruler mode when in the profile map
window.

Map Blend now works correctly with data containing large data spikes:
Map Blend will now display properly when showing data with large data spikes.

Discrete point map processing improved:
Subtraction and Spectral Math now work better with Discrete Point Map data.

PCA and PCA Recalculation improved:
At times the PCA and PCA Recalculation principle component window was empty, they are now populated
correctly.

Initialization failure message for Continuum/Semprex Stage:
At initialization the failure message no longer appears for the Continuum and Semprex stage combination.

Overlay of chemical image and video image in transmission is working correctly:
The Map Blend option did not work correctly when in transmission.

Map information for array maps is now correct:
The number of spectra collected with the array is now correct.

Translation Updates:
The translation files have been updated.

OMNIC Atlµs 8.0

New Features
Support for Windows Vista
OMNIC Atlµs can now be used with Windows Vista.

MCR
MCR calculation will be faster than in previous versions of the software.
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The result window has also changed and now shows all of the component spectra in a stacked display instead
of requiring the user to scroll through them.

Interactive Kramers-Kronig:
Interactive Kramers-Kronig for map data is now implemented

Discrete Point collections and apertures:
The aperture values are saved and used during collection for each discrete point map. This will require that a
different background with each aperture is collected for each point.

Resolved Issues
Large map processing:
Some enhancements have been added to the software to better support large map file processing.

Spline Smoothing is default:
Spline smoothing is now the default option for the initial display of the map window.

Video calibration with IR and Raman systems:
When switching between IR and Raman the video calibration information is switched also.

PCA and the arrows:
The navigation arrows in PCA were not working correctly, they are now working as expected.

Truncate Data set:
Truncate data set now writes correctly to the data file.

Known Issues
Opening experiment files with map information saved and OMNIC Atlµs window
open:
When opening experiment files with map information saved and the OMNIC Atlµs window open, the map may
not display as expected (the area rectangle, line or discrete points). If they do not appear, just close and
reopen the OMNIC Atlµs window to get them to display.

OMNIC Atlµs 7.4

New Features
Desktop Icon / About Dialog / Splash screen
The desktop icon for OMNIC Atlµs , the About dialog information and the OMNIC Atlµs splash screen have
been updated with new company branding information.
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Help
The help information for OMNIC Atlµs software has been changed to HTML. Some behavior found in previous
versions of the software may be different.

Save Video Image
Save video image will now save images as default in .jpg format instead of .bmp format.

Discard Small Variances:
The Discard Small Variances option in the Principal Component Analysis window improves the PCA results by
"zeroing out" very low intensity spectra.

Sigma button in PCA:
Click the Sigma button in the Principal Component Analysis window to see the overall strength of each
component at all measured sample points in the map. The symbol on the button becomes blue. In this mode
you can still click above the component numbers to display components, but moving the cross hairs in the
contour map has no effect on the component strength bars. (Moving the cross hairs just displays the spectrum
collected at the new location.) To return to the normal mode, click the Sigma button again.

Deleting map files:

Smooth:
map has now been added to the list of possible files to delete in the Delete Files command in OMNIC.

Smoothing is now the default state when displaying data in the map window.

Resolved Issues
Single Beam collections:
The single beam collection for collections with a final format other than single beam has been corrected.

Use Stored Focus Locations:
The option for using stored focus locations previously used only for Discrete Point maps in the Focus dialog of
Experiment Setup now applies to all types of map data collection.

Optical Velocity:
Previously known as the velocity parameter, the value indicates twice the velocity of the moving mirror rather
than the mirror velocity.

Clip Data Outside Color Range:
The clip data outside color range option works on both 3-D views of the data and for the 2D data display.

Smoothing Default:
The default polynomial order for smoothing is now 1 instead of 4

Automatic Full Scale:
Automatic full scale now works following a Full Scale operation.
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Visualization tools installation:
Issues were addressed to correctly install the visualization tools for the OMNIC Atlµs software.

PCA arrows:
The arrows in the PCA analysis window previously did not work correctly, they were backwards. This issue has
been addressed and the arrows now work as expected.

Large Discrete map collections:
Large discrete map collections can now be completed correctly. Previous errors may have prohibited discrete
map collections larger than 100 points to fail.

Microscope User’s Guide Link:
The Microscope User’s Guide Link is now functioning correctly and launching the appropriate help file.

Microscope Tour:
The Microscope Tour has been removed from the software.

OMNIC Atlµs 7.3

New Features
ATR Calibration
Calibration can now be done by using the ATR Calibration button in the System Configuration dialog. If ATR is
available the user will see this button. The user can create calibrations for the ATR crystals and retrieve them at
a later time just as they do with video calibrations.

Digital Camera Support.
Support has been added to the OMNIC Atlµs software to support a digital camera. Please contact our sales
representative to get available digital camera options. The user can now select to use a digital camera and
modify the camera settings.

Video Cropping
For customers with a digital camera, there is support for video image cropping. The video cropping is available
in the System Configuration dialog.

Duplicating video calibrations
A new option was added to allow the user to duplicate currently existing video calibrations so they can be
slightly modified for new calibrations.

Resolved Issues

Thermo Scientific Release Notes OMNIC Atlµs Software

29



Splitting map files
In previous versions of the software the split spectral files all contained the same time and date information in
the header when split from the map file. This has been modified and the spectral data files now contain time
and date information that reflects the collection progress.

Sieves in Image Analysis
When deleting sieves in Image Analysis the deleted sieve would not be removed from the list correctly. This
issue has been addressed and the deletion works properly. Sieve properties can only be used once, for
example two separate sieves 500 <Area and Area <2000 cannot be added to the sieve list. Area can only be
used as a property in one sieve. Because of this, sieve properties that currently exist in the sieve list will be
removed temporarily so they cannot be used again. When sieves are deleted the properties will be added back
to the list.

Save profile as CSV
Saving line map profiles only worked in previous version by copying the spectrum to another OMNIC window
and selecting Save from the file menu to save as CSV. This can still be done, but the Save profile as CSV
menu item in the OMNIC Atlµs menu will perform this task also.

Image analysis and video
To use Image Analysis with the video image, the video pane must be displayed. In previous versions of the
software you could select video image without the video pane being displayed and the Image Analysis window
would be empty.

Blend video and 2D
The color scheme and smoothing options selected in the map window are now honored in the blend video and
2D display window.

Estimated Collection Time for ViewStage
The estimated collection time for ViewStage collections is now closer to the actual time.

Create Calibration Dialog cue cards
Cue cards now work correctly in the Create Calibration dialog.

User home position
If a user home position had been defined, the XY position displayed in the OMNIC Atlµs window was not
correct following a stage initialization. This required OMNIC to be restarted.

This has been corrected and the XY cursor position is now correct following stage initialization.

Display Setup Y axis display
The Y axis display was not working correctly with the checkbox option in Display Setup, this issue has been
addressed.

Line map stepping
When stepping through the line map points, the first point is no longer skipped. Previous versions of the
software sometimes skipped this point if the user did not select the correct position.
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ATR Crystal prompt
Additional text was added when prompting for the ATR crystal.

Image Analysis
When clicking on a result in the Image Analysis histogram, the corresponding feature is now highlighted.

Z position slider
The Z position slider is now working correctly.

OMNIC Atlµs 7.2a

Resolved Issues
Aperture
Experiment aperture information is now updated from both the Aperture Dimensions dialog and by using the
pointer tool in the OMNIC Atlµs window if the experiment file aperture type is set to Rectangular. If the aperture
value in the experiment file is set to None, adjusting the aperture with the Aperture Dimensions dialog or by
using the arrow tool will not update the experiment file parameters. When resetting the aperture to the default
setting, the experiment file parameters will also be reset to the default settings. Therefore, the current aperture
setting, if set to rectangular in the experiment file, will be used during collection.

Image Analysis with MCR and PCA
All components can be used for Image Analysis from the MCR and PCA windows. Previously, only component
one could be used in Image Analysis.

Saving a profile to CSV
Saving an area map profile will save correctly, previously it used only the profile saved during the collection.

ATR Break after cancellation of collect
After canceling an ATR collection the ATR will break contact with the sample. This will prevent any potential
damage to the sample.

OMNIC Atlµs 7.2

New Features
Image Analysis.
Image analysis has been added to allow the user to get more information from the video and chemical images.
Users can apply filters to the image to sharpen, reduce noise or smooth the data. The user can then select
multiple parameters and use Feature Sizing to get feature information from the image data. Feature information
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may include area, perimeter, circularity, feret, or center of mass measurements. Image analysis can be
performed on the image displayed in the window, including zoomed images.

Multivariate Curve Resolution.
The user can perform Multivariate Curve Resolution on the map data to find pure component information.
Along with Principal Component Analysis this can be a powerful tool to get additional information from your
dataset.

Oversampling
Oversampling is now a linear array collect option.

New tools on the Principal Component Analysis window
New tools have been added to use on the PCA window. The user can now use a circular mask tool and a
polygon mask tool. Using Image Analysis the user may also specify a mask created by the Image Analysis.

Ruler tool on the map window.
A ruler tool has been added to the video and 2D image of the map window.

Support for the WDM cameras
Support has been added for WDM cameras. We now offer the option of purchasing a 2 megapixel WDM
camera to use with the OMNIC Atlµs 7.2 and µView 7.2 software. These cameras can be configured in the
System Configuration dialog just like the previous cameras.

Added a configuration option for Continuum without automation
A new configuration option was added to support Continuum microscopes without automation.

Alpha blending is added to the Blend 2D and video window
Alpha blending is added to the Blend 2D and video window. The user can now specify how much of either
image should be blended.

Right click option to make video image and chemical image the same size
A new right click menu item has been added to the video image right click menu. This menu option, Match
chemical image size, will set the chemical and video image to the same size. This can be useful when using
Blend 2D and video image.

Copy video image command
A Copy Video Image command has been added to the Edit menu in OMNIC. This will allow the user to copy
the live video image when the OMNIC Atlµs window is visible. The user may also copy the video image window
by using the Copy command in the Edit menu.

Z stage initialization updates
If the Z stage is not initialized certain tools in the OMNIC Atlµs window toolbar and buttons in the System
Configuration dialog will not be available. The tools that are not available will have red lines through them to
indicate that they are not available.

Ruler measurements
The ruler measurement value has been added to the status window in the OMNIC Atlµs and map windows.
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PCA Recalculation
The user can now use the PCA data and recalculate the data cube by selecting PCA recalculation. The user is
able to remove information from the original cube to build a new cube.

Linear Array information is now global
Linear array element and row information is now stored in the option information. The user can select the
information just as they did in OMNIC Atlµs 7.1 and OMNIC Atlµs 7.1a, but the information will be stored
globally and it will not change with each experiment file.

Audible tone at the end of collection
An audible tone option at the end of collection has been added to the collect options.

Saving multiple map profiles in one map file
Now you can save more than one profile in one map profile. You can create the profile, select the Save button
and name the profile. You may also see each of the profiles using the Show Current Profile option. Profiles can
be deleted when displaying in the profile window.

Import and Export of JCAMP files.
OMNIC Atlµs map files can be split into JDX or JCAMP files. Users can also select the Import command from
the file menu and open up multiple JCAMP files to create a line map.

Importing multiple SPA and CSV files.
By selecting multiple SPA and CSV files, the user can create a linear map file.

Limit Stage Travel icon indicator
When the Limit Stage Travel option is on the user will see a new icon in the upper left corner of the OMNIC
Atlµs window. The user will also see more messages when they try to select maps outside the limits of the
stage travel.

New Copy and Print options in the Blend 2D and video dialog
Users will now be able to copy and print the information displayed in the Blend 2D and video dialog.

ESC will stop animation
By pressing the ESC key while animation is running, the animation will stop.

Color bar thresholds
For those 3D images with a high intensity peak the limits can be changed to truncate the data so the peaks at
lower intensity can be visible.

RGB display for Quant
The RGB display can now be used with Quant data.

Copy more than one spectrum from window
The user can now copy more than one spectrum from the map window to an OMNIC window.

Set Home to Current right click option
Set home to current is now a right click option in the OMNIC Atlµs window. You can also access this from the
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Move Stage dialog.

Saving ruler and annotation overlays
Ruler and annotation overlays are saved with the image.

New option to hide cursor in 2D and 3D panes.
The cursor can be hidden in the 2D and 3D panes of the map window.

RGB blending controls
New controls have been added to the RGB window to modify the amounts for Red, Green and Blue in the
blended image.

Waterfall Display
The 3D display setup options allow for a waterfall display similar to the display in the OMNIC Atlµs 2.6 software.

Integrated Menus.
Menu items such as opening a map file, saving a map file, map processing commands and OMNIC Atlµs help
are now integrated into OMNIC menus. All OMNIC Atlµs menu commands were previously located only in the
OMNIC Atlµs menu.

Integrated Experiment Setup.
When setting up an experiment, the user can enter experiment information all in Experiment Setup. Collect and
bench information can be set in the Collect and Bench tabs and mapping specific information can be set in the
Mapping tab. All experiment parameter information will be saved in the experiment file when saved and
retrieved when the experiment file is reopened.

Flexible data windows
When viewing data in OMNIC Atlµs 7.1, the windows are flexible. The panes can be resized and the window
panes may be hidden or displayed. The user has the option to set up an initial window layout in Options and
then later modify that layout specifically for each map display.

Integrated mapping options.
Mapping options are now integrated under the Options menu item in the Edit Menu. Options such as
annotation colors, default step size and initial mapping display window options can be set similar to window
options in standard OMNIC.

Support for the Continuum XL
The OMNIC Atlµs 7.1 software supports the full mapping capabilities of the Continuum XL. In Experiment
Setup users can select the array detector, select the pixel and rows options and collect array data.

New 3D and 2D displays
The OMNIC Atlµs 7.1 software has new 2D and 3D displays of the map data. The 3D display can be rotated
and panned and colors can be changed from the mapping window.

Display Setup works with 2D and 3D displays
By selecting Display Setup from the View menu, the user can manipulate all standard map, 2D, 3D and video
parameters.
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System Configuration for Microscope systems
All system configuration settings such as microscope com port settings, autofocus options, ATR options,
camera selection and XY stage selection can be found under the System Configuration menu item in the
OMNIC Atlµs menu.

Calibration files
OMNIC Atlµs 7.1 no longer supports separate calibration .cal files. All calibrations are saved and can be
selected from the System Configuration options under the OMNIC Atlµs menu. Default calibrations are also
available at installation time for some standard calibrations.

Single point data collections
When collecting single point data, all of the data is stored in a single map file. The collected data can also store
video information if desired.

Security
OMNIC Atlµs 7.1allows users to add a digital signature to the map files. Other OMNIC DS security features are
also implemented. See the OMNIC documentation to get more information.

Video mosaic
When viewing the map data the video mosaic display is always displayed. There is no longer the need to go to
a separate window to view the mosaic. The mosaic can also be copied and printed.

Quantify
When using Quant as the selected profile, the quantify command is integrated into OMNIC using Quant Setup
and Quantify. The user can now display more than one component in the quant results.

Principal Component Analysis
OMNIC Atlµs 7.1 provides Principal Component Analysis (PCA) capability. The user may perform PCA on the
original map data, derivative data or smoothed data.

Blending
The 2D display and the video display can be blended together.

Right Click menus
OMNIC Atlµs 7.1 provides support for right click menus. Many commands in both the OMNIC Atlµs window and
the map window displays can be found by right clicking in the selected pane. Data can be copied, panes can
be hidden and video source parameters can be modified.

Process functions performed in memory
When processing map data, the functions will be performed on the data in memory. The results will not be
written to disk until the user chooses to save the data or the user will be prompted when map windows are
closed for modified data. Some process functions have been modified to be interactive. The user may select
specific map spectra to view the results prior to modifying the entire data cube.

Access from OMNIC Atlµs to all help documentation
All microscope and OMNIC Atlµs user documentation can be accessed from the Help menu.
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Import/Export
ENVI data files can be imported and exported from OMNIC Atlµs 7.1. Data can also be exported to OMNIC
Atlµs 2.6b format.

New file format
OMNIC Atlµs 7.1 supports a new file format that supports larger data sets.

Save Image
Video images can be saved in more formats than before. They can now be saved in jpeg and tiff formats as
well as bmp.

New OMNIC Atlµs window tools
New tools have been added to the OMNIC Atlµs window. The user can now select calibrations from the toolbar,
move to marker positions, and step through the data point locations, view full stage range and go to home
position all with the click of a tool.

Limit stage travel
Users can limit the travel of the stage, this can be set up manually or with the help of a wizard.

Reset home position
Home position can be reset to any position the user specifies. It no longer has to be at the center position.

Stage initialization
Stage initialization no longer happens automatically when the software is started or the system is powered up.
The user has the ability to initialize the XY stage anytime and to initialize the Z stage when required after a
system is powered back up.

Change data spacing
Data spacing can be changed on map files both spectrally and spatially. The spatial data spacing change adds
the pixels.

Truncation
Map data can be truncated both spectrally and spatially.

Split map files
All map files can be split into separate spectral data files. The data files can be .spa, csv or gaml files. Even
discrete point collection map files can be split into separate data files.

RGB
After performing PCA on the map data. The user has the option to blend the components in the RGB display
window. Each of the components may be selected to blend together to see the results.

Delete data points
When collecting discrete data the user can delete data points as well as add data points.

Animation
The map data can be animated to step through all frequency values in the data cube. The 2D and 3D displays
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will update as the animation is running.

Support for the new XL Mapping Stage
OMNIC Atlµs 7.1 supports the new XL mapping stage.

Support for the new XL Data Grabber card
OMNIC Atlµs 7.1 supports the new XL Data Grabber card.

Resolved Issues
Updated message when running µView and OMNIC Atlµs at the same time.
When OMNIC Atlµs and µView are running at the same time there may be conflicts with the video. This
information has been added to a message that will appear when either application is launched while the other
application is running.

Discrete points were not added correctly.
When multiple discrete sample points were added and deleted they did not update correctly.

Zooming to a single point in OMNIC Atlµs window.
Zooming to a single point in the OMNIC Atlµs window did not work correctly. Now this point will be centered in
the window.

Array map did not snap to array size less than 28 pixels.
The array did not snap to an array size less than 28 pixels.

Line map profile axis units.
The units of the line map profiles were updated to show intensity.

Mosaic capture speed up.
The mosaic capture feature speed has been improved.

Color box redraw problem fix.
When the color box was closed the window did not redraw correctly.

Using "Background File" collect option.
This option no longer requires the user to select a background point in the map sequence.

Limit Stage Travel near edge of stage.
When collecting a mosaic near the edge of the stage, the user is limited so the collection is not incorrect, this
helps ViewStage and MicroStage users.

Viewstage users required to go into System Configuration.
View Stage users were required to go into System Configuration to get the stage to move.
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Copy spectrum from the profile window for line map profiles.
Users can now copy the profile from the profile window for line map profiles.

3D display setup options.
Users can now see a wireframe display without surface and the profile lines work to display in the different
planes.

Full Range in PCA.
Full range in the PCA right click menu on the spectrum only set the contour and 3D display to full range, not
the spectra.

Split map was missing a file.
When splitting a map the end result has one less spectrum than it should have.

Updated help.
Fixed some issues with context sensitive help and help buttons.

Display Setup does not always work for Raman data
Display setup sometimes did not appear for Raman data, profile data.

ATR map does not prompt for Crystal insertion
A prompt was added for crystal insertion during ATR mapping.

ATR map should not contact sample when collecting background
When collecting background with ATR the sample should not be in contact.

Frequently Asked Questions
Why do I get a -1 value for perimeter of a feature?
When a feature is very small, less than one pixel wide, the feature size perimeter will be set to -1.

Why are some of my OMNIC Atlµs tools crossed out with a red line?
When initialization of the Z stage has not been completed, all of the buttons that require Z information will be
unusable by the user.

Why does my sample map shift on my video image?
When using the save map relative option with a linear array, your sample map overlay will appear shifted, this
option should be used carefully when using the linear array.

Why is my step size equal to 1.0 for Change Data Spacing on an array map?
The step size is set to 1.0 to indicate one pixel.

Why can’t I see my spectrum?
The spectrum window y-axis limits are set by the first spectrum shown. If automatic full scale is not selected,
the y-axis limits do not update for each spectrum and if the y-axis limits of the spectrum are not within the limits
of the window, it will appear that the spectrum is invisible. To remedy this, select the automatic full scale menu
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item in the View menu or use the right mouse button in the spectrum window to select a menu of operations.
Select full range to auto scale the entire spectrum.

Why is the Z Initialization button disabled in System Configuration?
Each time the microscope is powered up the Z stage initialization will need to be completed or the user will be
warned when showing the OMNIC Atlµs window. After the initialization, Z initialization is not necessary and the
button is disabled until the system goes through another power cycle.

Why can’t I see the residual in PCA in the spectrum window?
Sometimes the user cannot see the residual in the spectral window, this is caused by a zero residual
component.

What are the units in the profile window?
The unit values shown in the navigation pane on the Profile windows indicate the units of the spectrum not the
units of the profile.

Where are my map files saved?
Map files are saved in the initial mapping directory which by default is the spectral subdirectory. The spectral
subdirectory was selected for security purposes, this can be changed to OMNIC Atlµs which it has been in past
versions of the software.

How do I stop animation?
To stop the animation in the map window, either select the Animation menu item again in the OMNIC Atlµs
menu or click on the X-View control.

Why can’t I see the y-axis label on the spectrum?
The Y-Axis label may not be visible in the spectrum window, if the option is selected in the Display Setup
options, resize the window so the full label can be displayed.

Additional documentation notes:
Image Analysis:
You can perform an analysis on an image displayed in a map window, profile window, PCA results window or
MCR window. If the user has zoomed in on an area of the image in the map (or other) window, that is now the
"image displayed in" the map (or other) window.

Display Limits:
In the Display Limits dialog box (available through Display Limits in the View menu), the features in the Map
View Ranges box work as described for the features in the Spatial Limits box shown in the "Setting and display
limits" section of the OMNIC Atlµs User’s Guide. The X Limits and Y Limits features are now named "X-Range"
and "Y-Range".

3-D View tab of Display Setup:
On the 3-D View tab of the Display Setup dialog box (available through Display Setup in the View menu), the
Show Surface and Profile Lines check boxes cannot be selected at the same time. This means that the 3-D
image can be displayed in the form of profile lines only without the surface plot present.
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Interferogram files?
Map interferograms (<map filename>_ifg.map) can only be viewed. Do not try to process these files or use
them with reprocess. These files are required to reprocess map files but you must select the map file not the
corresponding _Ifg.map file.

PCA
When one of the spectra is bad, truncate the map to avoid the bad pixel.

Known Issues
Context Sensitive Help
Not all controls and dialogs have context sensitive help, please refer to the OMNIC Atlµs Help Topics or OMNIC
Atlµs User’s Guide options in the Help menu for more information.

OMNIC Atlµs Installation Directories

When you install OMNIC Atlµs 8.0 the default (recommended) directories depend on whether an earlier version
of OMNIC Atlµs is on your system.

If an earlier version is not present, the default folders are C:\My Documents\OMNIC for data files, and
C:\Program Files\OMNIC for program (executable) files and Help files. Within the C:\My Documents\OMNIC
folder, the following folders will be created: Spectra for saving maps automatically after a data collection, Quant
for quantitative analysis methods, and Param for experiment files. Other optional software programs may add
other folders to the C:\My Documents\OMNIC folder.

If an earlier version of OMNIC is present, the default data directory is the directory where the earlier version
was installed (usually C:\OMNIC). The default directory for program files is where the earlier version was
installed (usually C:\Program Files\OMNIC).

In either case, you can specify that other directories be used if desired.

In addition to these directories, OMNIC installs the runtime ToolBook 5.0 files in the Windows\Asym\Runtime
directory and the runtime ToolBook 6.0 files in the Program Files\ Asymetrix\Shared Tools\tbsystem directory.
These files are used by OMNIC Macros\Basic and the tutorials.

Atlµs for Dispersive Raman Release Notes

The OMNIC Atlµs Microscope Software lets you perform automated data collection and spectral mapping
experiments with your microspectrometer system. You can automatically collect different types of compositional
maps and display the collected data in a variety of formats. You can also create reports containing map data
and print contour maps, 3-D displays, and comprehensive video images of the sample. Depth profile
collections can be done for a line or an area.
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Atlµs for Dispersive Raman 8.3 (Sep-2011
Release)

New Features
Added support for 64-bit Windows

Atlµs for Dispersive Raman 8.2 (Jul-2010
Release)

New Features
Added support for Windows 7

Atlµs for Dispersive Raman 8.1 (Dec-Hotfix)

Resolved Issues
Collect Map Background menu items removed:
Collect Map Background menu items have been removed from the menu when using OMNIC for Dispersive
Raman with OMNIC Atlµs.

Add Background Point right click menu item has been removed:
The Add Background Point right click menu option has been removed from the menu when using OMNIC for
Dispersive Raman with OMNIC Atlµs.

Truncating a Data Set does not give Invalid Value message:
In previous versions of the software when trying to truncate a depth profile map the software reported an
Invalid Value.

Adding a marker previously failed:
In the previous version of the software adding a marker with the Marker toolbar tool generated an error
message that has been corrected.
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Atlµs for Dispersive Raman 8.1

Resolved Issues
Depth profile map information:
Line depth profile maps now display the correct number of points in the map information instead of just 1.

Improved estimation of map collection time:
The estimated collection time of a map with auto-exposures has improved.

Workaround to get better resolution quality:
To get better image quality we recommend sending the video image to a virtual printer driver such as Microsoft
Office OneNote, Microsoft Office Document Image Writer or a similar product. The two applications mentioned
above are both part of the Microsoft Office Suite or they could also be downloaded from the Microsoft website.
By using any of these types of products you can print the document to the driver which will save the image
directly to a file or to an application for viewing, which is typically in the printer resolution of 300 dpi or higher.
The image can then be copied and pasted into any document.

OMNIC Atlµs window annotation no longer bleeds through onto the Experiment
Setup window:
The OMNIC Atlµs window annotation no longer bleeds through into the Experiment Setup window.

Atlµs for Dispersive Raman 8.0


"Atlµs for Almega" has now been changed to "Atlµs for Dispersive Raman". This software
can be used with our Almega and DXR products.

New Features
Support for Windows Vista:
Atlµs for Dispersive Raman can now be used with Windows Vista.

Support for DXR microscope:
Support functions have been added for the DXR Microscope instrument.

Resolved Issues
Split map files:
Splitting line map files failed in previous versions, it is working now.
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Map collection estimated time:
The map collection time estimation has been updated.

Atlµs for Almega 7.4

New Features
Desktop Icon / About Dialog / Splash screen
The desktop icon for OMNIC Atlµs, the About dialog information and the OMNIC Atlµs splash screen have
been updated with new company branding information.

Help
The help information for OMNIC Atlµs software has been changed to HTML. Some behavior found in previous
versions of the software may be different.

Save Video Image
Save video image will now save images as default in .jpg format instead of .bmp format.

Discard Small Variances:
The Discard Small Variances option in the Principal Component Analysis window improves the PCA results by
"zeroing out" very low intensity spectra.

Sigma button in PCA:
Click the Sigma button in the Principal Component Analysis window to see the overall strength of each
component at all measured sample points in the map. The symbol on the button becomes blue. In this mode
you can still click above the component numbers to display components, but moving the cross hairs in the
contour map has no effect on the component strength bars. (Moving the cross hairs just displays the spectrum
collected at the new location.) To return to the normal mode, click the Sigma button again.

Deleting map files:

Smooth:
map has now been added to the list of possible files to delete in the Delete Files command in OMNIC.

Smoothing is now the default state when displaying data in the map window.

Objective:
The list of possible objectives has been modified to include another option.

Resolved Issues
Clip Data Outside Color Range:
The clip data outside color range option works on both 3-D views of the data and for the 2D data display.
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Smoothing Default:
The default polynomial order for smoothing is now 1 instead of 4

Automatic Full Scale:
Automatic full scale now works following a Full Scale operation.

Visualization tools installation:
Issues were addressed to correctly install the visualization tools for the OMNIC Atlµs software.

PCA arrows:
The arrows in the PCA analysis window previously did not work correctly, they were backwards. This issue has
been addressed and the arrows now work as expected.

Microscope User’s Guide Link:
The Microscope User’s Guide Link is now functioning correctly and launching the appropriate help file.

Microscope Tour:
The Microscope Tour has been removed from the software.

Splitting depth profile map files.
Splitting depth profile maps created with 7.3 now works properly.

Copy the profile pane using the right click menu in the profile window for depth
profile maps.
The copy and paste function did not work properly when copying the profile pane from the profile window in 7.3
when using depth profile maps. This now works properly in this version.

_Ifg files:
_Ifg data files will no longer be saved with Almega data collections since this data is not needed for dispersive
Raman.

Joystick for the Microstage.
The joystick is now working properly with the Microstage hardware.

Atlµs for Almega 7.3

Addressed Issues
Splitting map files.
Splitting discrete point maps into separate spectral data files now works properly.
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Atlµs for Almega 7.2

New Features
Image Analysis.
Image analysis has been added to allow the user to get more information from the video and chemical images.
Users can apply filters to the image to sharpen, reduce noise or smooth the data. The user can then select
multiple parameters and use Feature Sizing to get feature information from the image data. Feature information
may include area, perimeter, circularity, feret, or center of mass measurements. Image analysis can be
performed on the image displayed in the window, including zoomed images.

Help documentation.
Help documentation has been combined with the OMNIC Atlµs User’s Guide and OMNIC Atlµs context
sensitive help.

Depth Profile mapping.
Depth profile line and area maps can now be collected with OMNIC Atlµs 7.1. Depth profile maps can be set
up from within Experiment Setup on the mapping tab.

Integrated Experiment Setup.
Experiment Setup for all map types is integrated with other experiment setup parameters using the Experiment
Setup tabs.

Addressed Issues
Limit Stage Travel near edge of stage.
When collecting a mosaic near the edge of the stage, the user is limited so the collection is not incorrect.

Viewstage users required to go into System Configuration.
View Stage users were required to go into System Configuration to get the stage to move.

Known Issues
Context Sensitive Help
Not all controls and dialogs have context sensitive help, please refer to the OMNIC Atlµs Help Topics or Atlµs
for Almega User’s Guide options in the Help menu for more information.

How to Contact Us

Current contact information is located at https://www.thermofisher.com
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Select the "Contact Us" icon at the top of the screen
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